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Release Notes 

© Copyright Computers and Structures, Inc., 2018 

Notice Date: 2018-07-27 
 

 

This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 
Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.0.0 (Released 2018-05-31) 

 

Licensing and Installation 
Enhancements Implemented 

* Incident Description 

 217927 The version number has been changed to v17.0.1 for a new minor release. ETABS v17 is available 
as a 64-bit version only in order to provide better performance. 

Modeling 
Enhancements Implemented 

* Incident Description 

 216061 
218564 

An enhancement was made for reinforced-concrete auto-hinges where the effective yield stress 
values for rebar are now used to obtain hinge capacities instead of the minimum yield stress. For 
older models which may not have an effective yield stress specified for the rebar the effective yield 
stress defaults to the minimum yield stress. The user can modify these values. Note that fiber 
hinges were already using the effective strength values for rebar stress-strain curves starting with 
version 17.0.0. Because the effective strength values were not being exported to the model text 
file (.e2k, .$et), imported models with fiber hinges containing rebar could fail to run in v17.0.0. 
These values are now exported and imported, and any models where the effective strengths for 
rebar materials are found to be zero are corrected by setting the effective strengths equal to the 
corresponding minimum strengths. 

 217200 An enhancement was made to make the error checking that is performed during the meshing of 
decks use a relative area tolerance of 0.01% instead of the previous value of 0.1% so as to be 
consistent with slab meshing, which was already using a value of 0.01%. An absolute check is now 
also performed. In addition, general meshing is now being used for decks after performing cookie-
cutting when further meshing based on maximum size is requested. Previously, rectangular 
meshing was used after cookie cutting in this case. General meshing provides better results for 
triangles and distorted quadrilaterals. 

 217577 An enhancement has been made to provide more user control over frame auto mesh options 
where minimum number of segments and/or maximum segment length can now be assigned to 
frames. 

 219244 An enhancement has been made to automatically assign a small amount of translation mass to link 
elements that are generated for shear (V2 or V3) hinges when "Model Hinges as Separate Link 
Elements (Permits FNA)" has been selected using the command Analyze > Analysis Model for 
Nonlinear Hinges. Previously, such mass was only assigned for hinge-links that activated the axial 
or rotational degrees of freedom. The addition of this small mass may improve FNA convergence 
behavior, and will avoid warning messages about no mass at these hinges that are generated when 
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* Incident Description 

running Ritz modal cases. Models with shear hinges modeled as links may exhibit small changes 
when run in the new version. The effect should be small for well-conditioned models, and may be 
improved for models that had difficulty converging in previous versions. 

 219454 An enhancement was made to allow adding of Tendons and Design Strips into a Group. 

Frame Design 
Enhancements Implemented 

* Incident Description 

* 216530 An enhancement has been made to add a new Chinese Steel frame design code named "Chinese 
2018". It is based on the GB50017-2017 steel-frame code, the GB50011-2010 seismic code, and 
the JGJ99-2015 tall-building code. 

 219046 A change was made in concrete frame design per the "SP 63.13320.2012" code to how load 
combinations are to be tagged as long-term loading. Previously all load combinations which had 
lateral loads (seismic or wind) were tagged as short term and all the remaining combinations were 
tagged as long term. Now those load combinations that contain only dead, superimposed dead, or 
prestress loading are tagged as long term and all the remaining combinations are tagged as short 
term. Tagging a load combination as short-term or long-term affects the factor Gammab1, which in 
turn affects the design values of the compressive and tensile resistance of concrete, Rb and Rbt. In 
addition to this change, the “Gamma_b1 Short Term” parameter is removed from the preferences 
menu as this value must always be 1.0 (unity). 

Graphics 
Enhancements Implemented 

* Incident Description 

 217898 Enhancements have been made to the DirectX 3D display mode to better handle openings in slabs 
and shrunken-object display. Other minor DirectX display issues were corrected (including 
selection, size of the moving red dot, extruded Section Designer shapes, and color of the bounding 
box). 

Data Files 
Enhancements Implemented 

* Incident Description 

 219178 An enhancement was made to add the "Project Information" data to the model text file (.e2k, .$et) 
so that this information can be retained for export/import. This data is specified using the 
command File > Project Information. 
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Drafting and Meshing 
Incidents Resolved 

* Incident Description 

 217234 
218653 

An incident was resolved where the option Snap to Grid Intersections sometimes did not work 
correctly in plan views when using the DirectX graphics mode, depending upon the zoom level. 
Results were not affected. 

 217244 
217480 
218092 

An incident was resolved where, in certain cases, the general mesher would change the shape of 
embedded objects or openings due to a dimension tolerance issue. When this happened, the error 
was obvious.  

 217476 An incident was resolved where, in rare cases, the operation to merge two shells into one would 
not work when expected. The error was obvious, and results were consistent with the model. The 
error was limited to version 17.0.0. 

 217953 An Incident was resolved where the command Edit > Edit Shells > Explode User Mesh to Shells 
would create shell objects with their shell section property assignment set to None rather than 
using the section property assigned to the parent shell object that had the user mesh. This would 
result in the new shell objects being excluded from the analysis, although it was easily corrected by 
re-assigning the expected section property. In addition, the new shell objects will have their Floor 
Auto Mesh assignments set to “No Auto Mesh”, so that no further meshing will occur unless this 
assignment is later changed by the user. 

 219456 An incident was resolved where openings could not be drawn for certain walls. This happened 
when the wall connectivity was such that the 1-2 edge was not at the bottom of the wall. 

Modeling 
Incidents Resolved 

* Incident Description 

* 217680 
217824 

An incident was resolved where the "Check Model" operation caused multiple incorrect error 
messages to be displayed and failed to complete when the “Check Meshing for All Stories” and/or 
the “Check Loading for All stories” options were checked. The results were not affected. 

Loading 
Incidents Resolved 

* Incident Description 

* 218122 An incident was resolved where certain load combinations reported the same value for the 
maximum and minimum response when the two values should have been different. Separate 
maximum and minimum values were being reported for a load combination only if ALL the 
contained load cases and combinations were double-valued, whereas separate values should have 
been reported if ANY of the contained load cases or combinations were double-valued. This error 
only affected version 17.0.0.  

Analysis 
Incidents Resolved 

* Incident Description 

 218321 An incident was resolved where an error could occur while creating the analysis model under the 
following rare condition: The model included a Walking Vibration analysis, and the model had been 
imported from a text file multiple times. This error only affected version 17.0.0. 
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* Incident Description 

 218524 An incident was resolved where the analysis could stop with an error message when running 
nonlinear static or direct-integration time-history load cases for models containing a large number of 
shell elements. This error was not common, but it was more likely when there were many layered 
shells with multiple layers and/or integration points. When this memory error occurred, results were 
unavailable for the affected load cases. Memory can still be exceeded for larger models on machines 
with limited RAM, but this incident was related to a fixed-size buffer that was independent of the 
amount of RAM, and has been corrected. 

 218566 An incident was resolved where nonlinear static load cases with load application specified to use 
Displacement Control would fail to run when generalized displacements were used in either of the 
following two situations: (1.) When generalized displacements were used as Additional Control 
Displacements, the analysis model could not be created and no load cases would be run. (2.) When a 
generalized displacement was used as the Monitored Displacement, the analysis would run, but the 
affected load case would terminate immediately with a warning that the monitored displacement 
was zero; no results were available for that load case. Both of these errors affected version 17.0.0 
only. 

* 219889 An Incident was resolved where the creep and shrinkage strains calculated during nonlinear staged 
construction load cases for frame objects could be incorrect when run in a multithreaded 
environment. This would normally be the case on any machine with more than 2 cores, unless the 
environment variable SAPFIRE_NUM_THREADS was set to 1 (unity). When this error occurred, 
results could vary from machine to machine, or from run to run on the same machine. Only ETABS 
version 17.0.0 was affected. Correct results could be obtained using v17.0.0 by setting the 
environment variable SAPFIRE_NUM_THREADS = 1 in Windows Control Panel before starting ETABS 
v17.0.0. This error only affected staged-construction load cases run in ETABS Ultimate when the 
time-dependent option was enabled for the load case, materials were defined to consider creep or 
shrinkage strain, and the stages in the load case had non-zero duration. 

Frame Design 
Incidents Resolved 

* Incident Description 

 213155 
213961 

An incident was resolved for steel frame design per the Russian code "SP 16.13330.2011" in which 
the section modulus was switched between major and minor axes bending when a singly-symmetric 
section, like a Tee beam or a Double-Angle section, had Wn,minor > Wn,major. The principal 
direction needed to rotate by 90 degrees in these cases. This affected the demand/capacity ratio for 
singly-symmetric flexural members having Wn,minor > Wn,major for bending about 3-3 axis, and 
was unconservative. Typical sections were not affected. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

* 217781 
218953 
218882 

An incident was resolved where, in some cases, a report could not be generated. This particular 
error was limited to version 17.0.0 and only affected models containing multi-stepped load 
patterns. Results were not affected. 

 218279 An incident was resolved where nonlinear static load cases with load application control specified 
as Quasi-Static were run using the default Monitored Displacement, rather than the specified 
displacement. Static pushover plots could not be plotted. All other results were consistent with the 
use of the default monitored displacement. This error affected only version 17.0.0. 

 218368 An incident was resolved where the strain value reported in the "Area Diagram" form shown by 
right-clicking an area element while viewing the strain diagram was incorrectly displayed in stress 
units. The strain value shown on the main display screen and in the database tables was correct. 
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* Incident Description 

 219136 An incident was resolved where models with nonlinear frame hinges using option "Model Hinges 
as Separate Link Elements (Permits FNA)" would cause the story response plots for shear and 
overturning moment, as well as the database tables of these quantities, to produce obviously 
incorrect values when the hinges were located at the ends of columns with no rigid offsets. This 
also affected user-defined Section Cut results when they were based on Groups that included such 
column members. No other results were affected. This error did not occur when the hinges were 
located away from the exact ends of the column, or when the hinges were modeled within the 
elements (not as separate links). 

 219204 An incident was resolved where an error message was generated when trying to plot the deflected 
shape for a nonlinear load case (static or time-history, including modal and direct-integration) for 
models containing an isotropic hinge assigned to a wall object. No results were affected, but the 
deformed shape (including animations) could not be plotted. Linear load cases were not affected. 
This error was not common, since most hinges assigned to a wall object are Fiber P-M3 hinges. The 
only hinges types that can be assigned to a wall that caused this error were Shear V2 with Isotropic 
hysteresis specified, and Interacting (non-fiber) P-M3 hinges, which are always isotropic. 

User Interface 
Incidents Resolved 

* Incident Description 

 218202 An incident was resolved where using the option to "Copy to SD Section" in the frame section 
property form would not work correctly if a "User" rebar size for the reinforcement in a concrete 
frame section was used. The error was happening based on the order of operations. If the rebar 
type was first changed to "User" and then the rebar area specified the error would not happen. 
However, if the rebar area was first specified and then the type was changed then the error would 
occur. 

Database Tables 
Incidents Resolved 

* Incident Description 

 217964 
219092 

An incident was resolved where the section cut table was blank when displaying the tabulated 
results of section cuts that were saved from the screen or defined based on quadrilateral cutting 
planes. An inadvertent check was introduced in version 17.0.0 causing the problem and it only 
affected this version. Section cuts defined by group were not affected. 

 219400 An incident was resolved where, in the Story Drifts table, the label for nodes where the maximum 
drift occurred was left empty. This affected version 17.0.0 only. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 219436 An incident was resolved in which the model text file (.e2k, .$et) was unable to be saved when T-
shapes or L-shapes within a section-designer section had corner rebar sizes specified as 'None' 
instead of a bar size. No results were affected. 
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External Import/Export 
Incidents Resolved 

* Incident Description 

 217768 An incident was resolved where the binary STL file created for 3-D printing could not be read by 
other software when the generated mesh for floors or walls contained triangular shell elements. 
Models with only quadrilateral shell elements were not affected. This issue affected ETABS version 
17.0.0 only. 

Application Programming Interface (API) 
Incidents Resolved 

* Incident Description 

 219705 An incident was resolved for the API (Application Programming Interface) where calling the 
SetMaterial function multiple times, in conjunction with one of the functions for specifying the 
property values, could modify the property values of already defined materials. The 
unintentionally modified values were visible via the forms and database tables. 

 219869 An incident was resolved where the API (Application Program Interface) functions 
cCaseStaticNonlinear.GetLoadApplication and .SetLoadApplication did not support the load 
application type for quasi-static control. Results agreed with the model. 

 


